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FIELDBUS COMMUNICATION

Cyber Security Legal Disclaimer

This product is designed to be connected to and to communicate information and data via a
network interface. It is your sole responsibility to provide and continuously ensure a secure
connection between the product and your network or any other network (as the case may
be). You shall establish and maintain any appropriate measures (such as but not limited to
the installation of firewalls, application of authentication measures, encryption of data, in-
stallation of anti-virus programs, etc.) to protect the product, the network, its system and
the interface against any kind of security breaches, unauthorized access, interference, intru-
sion, leakage and/or theft of data or information. ABB Ltd and its affiliates are not liable for
damages and/or losses related to such security breaches, any unauthorized access, interfer-
ence, intrusion, leakage and/or theft of data or information.

Risk Mitigation and Secure Deployment

The idea is to create defence-in-depth protection for each network by allocating firewall solu-
tions to the front of internal trusted networks of each network by manage firewalls, their
configurations and access rules. The softstarter must be positioned in a trusted network,
strictly limited and in a hosted portion of a network or control system. Configure firewalls ac-
cording to the principle of denying everything that is not needed nor used. For secure remote
access, use a VPN connection with an encryption layer to create a secure channel over an inse-
cure network. For more information regarding cyber security and risk mitigation, download
the document from the ABB library.

] Information

| The device uses the default Modbus TCP port 502 (0x01F6). This port must be
open in the firewall for both incoming and outgoing traffic to allow Modbus-TCP
compatible devices to communicate.
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1.

FIELDBUS COMMUNICATION

Modbus TCP

Modbus is a master-slave protocol and only one device can transmit on the line at any time.
The master (which in most cases is a PLC) manages the exchanges and only it can take the
initiative. It interrogates each of the slaves in succession and no slave can send a message un-
less it is invited to do so. The master repeats the question when there is an incorrect ex-
change, and declares the interrogated slave absent if no response is received within a given
time period. If a slave does not understand a message, it sends an exception response to the
master who may or may not repeat the request.

The Modbus protocol is a fieldbus protocol that provides full control and status information
of the softstarter, reading as well as writing of parameters. Through the fieldbus it is possi-
ble to start and stop the motor, read out currents and frequency, get information about pro-
tections, warnings, faults and much more.

See chapter 8 in the Installation and commissioning manual, document 1SFC132081M0201,
for fieldbus related settings.

Before the Modbus RTU can be taken in operation following parameters must be set in the
softstarter:

— Parameter 12.2 FB interface connector set to Anybus

— Parameter 12.3 Fieldbus control set to On (if using fieldbus only to monitor this parameter
can be set to Off)

— The parameters controlling the Anybus CompactCom module IP settings needs to be set
to match existing network configuration:

. Parameter 12.5 Fieldbus IP address
« Fieldbus 12.6 IP gateway

« Fieldbus 12.7 IP net mask

« Fieldbus 12.8 IP DHCP client

] Information
_|h| After changing any of the communication parameters it is needed to perform a
power cycle of the device for the parameter values to be taken into effect. Or an-
other way for a commu-nication parameter value change to be taken into effect
is to set parameter 12.2 FB interface connector to “None” and then set it back to
“Anybus”.

If there is no message passed between the PSTX softstarter and the Anybus
module for more than the configured fieldbus failure timeout time (parameter
19.12), the PSTX softstarter will trip on fieldbus communication failure protection
(P1E0O) and with the default configuration the motor will be stopped. If the com-
munication system is setup in such a way that commands/requests are not con-
tinuously passed between the PLC and softstarter, this protection function
should be disabled. The parameter 19.4 (Fieldbus failure op) can then be set to
“Off”.
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2.1.

2.2.

FIELDBUS COMMUNICATION

Caution!
A The motor may start unexpectedly if there is a start signal present when doing
any of the actions listed below.

— Switching from one type of control to another (fieldbus control/hardwire
control)

— Reset all Settings

] Information
_|h| When fastening the module into the com1 port, make sure that the module is
properly aligned in the socket prior to applying any force. Rough handling and/or
excessive force in combination with misalignment may cause mechanical dam-
age to the module and/or the com1 and socket.

Modbus Addressing

When talking about Modbus addressing, there is often a misunderstanding about what an
address really is. This section will try to clarify the conventions in this document.

Protocol Address

The Modbus standard specification uses one kind of address, a two byte unsigned integer (0-
65535).

This is the address that is actually transmitted to the device.

Modicon Address

Modbus was originally developed by Modicon and the notation used then is still often used
today, though considered obsolete by present standards.

The Modicon notation combines two pieces of information in a single number:
1. Theregister type
2. The register number

A register number offset defines the type and makes it possible to translate between the two
types of addresses.

Table 1 Register types and ranges

Prefix Register Type Range

Ox Coil 00001-00001

1x Discrete Input 10001-19999

3x Input Register 30001-39999

4x Holding Register 40001-49999
STATUS SECURITY LEVEL DOCUMENT ID. REV. LANG. PAGE
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FIELDBUS COMMUNICATION

2.3. Translating Modicon address to protocol address

An example:
Modicon address 40002 selects the holding register at protocol address 0001 (40002 — 40001
=1). The protocol address 0001 will be transmitted in the message packet.

3. PSTX Data

3.1. Digital input telegram

To PLC from the softstarter.
Use Modbus function code 02, Read Input Status.

Protocol Modicon Bit Data Description

Address Address

0000h 10001 0 Auto Mode status! 0 = softstarter control from
fieldbus not allowed.

0001h 10002 1 Event status 0 = No active fault/warn-
ing/protection.

0002h 10003 2 Ready To Start 0 = A start will probably

cause a fault,
1 = A start will probably not
cause a fault.

0003h 10004 3 FBT Response O See Fieldbus Tasks.

0004h 10005 4 FBT Response 1 See Fieldbus Tasks.

0005h 10006 5 FBT Toggle Bit See Fieldbus Tasks.

0006h 10007 6 Programmable Digital Input 1 Function of programmable
0007h 10008 7 digital input, see section 3.2
0008h 10009 8
0009h 10010 9
000Ah 10011 10 Programmable Digital Input 5
000Bh 10012 11 Programmable Digital Input 6
000Ch 10013 12 Programmable Digital Input 7
000Dh 10014 13 Programmable Digital Input 8
O0OEh 10015 14 Programmable Digital Input 9
OO0OFh 10016 15 Programmable Digital Input 10

Programmable Digital Input 2
Programmable Digital Input 3
Programmable Digital Input 4

D Auto mode reflects the control state of the Softstarter. This is affected by a combination of:

The Auto mode input signal from the PLC (Digital output telegram).

The state of the Local/Remote switch on the HMI.

The parameter “Fieldbus control”.
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3.2.

FIELDBUS COMMUNICATION

The digital input “Fieldbus disable”.Programmable

Digital Inputs

The functions of the programmable Digital inputs are controlled by the parameters Fieldbus
DI 1 through Fieldbus DI 10. The following functions are available for selection:

Function Data

None Value is set to O.
Start feedback Status of Start signal.
Stop feedback Status of Stop signal.

Fault reset feedback

Slow speed reverse feedback

Slow speed forward feedback

Start 1 feedback

Start 2 feedback

Start 3 feedback

Motor heating feedback
User defined feedback
Stand still brake feedback
Emergency mode feedback
Start reverse feedback

Run status

TOR status

Line

Phase sequence

Event group O status
Event group 1 status
Event group 2 status
Event group 3 status
Event group 4 status
Event group 5 status
Event group 6 status
Sequence 1 Run status
Sequence 2 Run status
Sequence 3 Run status
Sequence 1 TOR status
Sequence 2 TOR status
Sequence 3 TOR status

Run reverse status

Enable status

Status of Reset signal.

Status of Slow speed reverse signal.
Status of Slow speed forward signal.
Status of Start 1 signal.

Status of Start 2 signal.

Status of Start 3 signal.

Status Motor heating signal.

Status of User defined protection signal.
Status of Stand still brake signal.
Status of Emergency mode signal.
Status of Start reverse signal.

1 =Indicates when the softstarter gives voltage to the
motor.

Top of Ramp. 1 = Indicates that motor runs on full volt-
age.

Line or Inside Delta Connection; O = Line, 1 = Delta.
0=1L1L2,L3;1=11,L3,L2.

0 = No active events present in group O.

0 = No active events present in group 1.

0 = No active events present in group 2.

0 = No active events present in group 3.

0 = No active events present in group 4.

0 = No active events present in group 5.

0 = No active events present in group 6.

Run status of sequence connected motor 1.

Run status of sequence connected motor 2.

Run status of sequence connected motor 3.

Top of Ramp status of sequence connected motor 1.
Top of Ramp status of sequence connected motor 2.
Top of Ramp status of sequence connected motor 3.

1 = Indicates when the softstarter gives voltage to the
motor after a reverse start.

Status of Enable signal.
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3.3.

FIELDBUS COMMUNICATION

Function

Data

Digital InO status

Digital Inl status

Digital In2 status

Local control status

Cancel brake feedback

Pump cleaning auto status
Pump cleaning forward status
Pump cleaning backward status

External digital 1DIO status

External digital 1DI1 status

External digital 1DI2 status

External digital 1DI3 status

External digital 1D14 status

External digital 2DI5 status

External digital 2DI16 status

External digital 2DI7 status

HW DI Start status
HW DI Stop status

Ready to start (line contactor)

Status of internal digital input InO.

Status of internal digital input Inl.

Status of internal digital input In2.

0 = Remote control, 1 = Local control (HMI).
Status of Cancel brake signal.

Status of automatic pump cleaning.
Status of forward pump cleaning.

Status of reverse pump cleaning.

Status of external digital input 1DIO (not supported
when using internal Modbus RTU).

Status of external digital input 1DI1 (not supported
when using internal Modbus RTU).

Status of external digital input 1DI2 (not supported
when using internal Modbus RTU).

Status of external digital input 1DI3 (not supported
when using internal Modbus RTU).

Status of external digital input 1DI4 (not supported
when using internal Modbus RTU).

Status of external digital input 2DI5 (not supported
when using internal Modbus RTU).

Status of external digital input 2DI6 (not supported
when using internal Modbus RTU).

Status of external digital input 2DI7 (not supported
when using internal Modbus RTU).

Status of the hard wire internal digital input Start.
Status of the hard wire internal digital input Stop.

Same conditions as the Ready To Start bit except that
the incoming three phase voltage condition is excluded.
The bit can be used when a line contactor is connected.

Analog input telegram

To PLC from the softstarter.

All analog data is represented as 16-bit values.
Use Modbus function code 04, Read Input Registers.

A protocol for Fieldbus tasks is used to read and write parameters. It is applicable for all

fieldbuses.
Protocol Modicon Data Representation
Address Address
0001h 30002 FBT Return Value See Fieldbus Tasks
0002h 30003 Programmable Analog Input 1 Function of programmable an-
0003h 30004 Programmable Analog Input2 209 input, see section 3.4
0004h 30005 Programmable Analog Input 3
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3.4.

FIELDBUS COMMUNICATION

Protocol Modicon Data Representation
Address Address

0005h 30006 Programmable Analog Input 4

0006h 30007 Programmable Analog Input 5

0007h 30008 Programmable Analog Input 6

0008h 30009 Programmable Analog Input 7

0009h 30010 Programmable Analog Input 8

000Ah 30011 Programmable Analog Input 9

000Bh 30012 Programmable Analog Input 10

Programmable Analog Inputs

The functions of the programmable analog inputs are controlled by the parameters Fieldbus

Al 1 through Fieldbus Al 10. The following functions are available for selection:

Function

Representation

None

Phase L1 current!
Phase L2 current!
Phase L3 current!
Active power (hp)
Active power
Apparent power
Mains voltage

Power factor

Motor voltage
Active energy (resettable)
EOL time to trip

Mains frequency

Max phase currentl

Motor current

Motor run time (resettable)
Motor temperature

Motor temperature percent
Number of starts (resettable)

Phase sequence

PT100 temperature

PTC resistance

Value is set to O
Value = 1000 = 100A
Value = 1000 = 100A
Value = 1000 = 100A
Value =1000 = 10hp
Value = 1000 = 10kW
Value = 1000 = 10kVA
Value =1000 = 100V

Value=100=>1
Example: 87 = 0.87

Value = 100 = 100%
Value = 1000 = 10kWh

Value =100 = 100s
Value = 65535 = No overload
Value = 0 = Trip already occurred

Value = 1000 = 100Hz
Value = 1000 = 100A
Value = 1000 = 100A
Value =100 = 1000h
Value =100 = 100°C
Value =100 = 100%
Value =1 =100

Value =0 = L1->L2->L3

Value =1= L1->L3->L2

Value = 2 = No sequence detected
Value =n = n/10-50°C

Example: 750 = 25°C

Value = 100 = 100Q
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FIELDBUS COMMUNICATION

Function

Representation

Reactive energy (resettable)
Reactive power

Remaining time to start
Thyristor temperature
Thyristor temperature percent
EOL time to cool

Top event code

Motor current in percent of IE.
Thyristor run time (resettable)

Motor connection

Phase L1 current high range?
Phase L2 current high range?
Phase L3 current high range?
Active power (hp) high range?
Active power high range?
Apparent power high range?
Reactive power high range?
Max phase current high range?
Max motor current high range?
Active energy high range?

Reactive energy high range?

Value = 1000 = 10kVArh
Value = 1000 = 100VAr
Value =100 = 100s
Value =100 = 100°C
Value =100 = 100%
Value =100 = 100s
Value =1000 = 1000
Value =100 = 100%
Value =1 = 10h

Value = 0 = auto

Value =1 = In-line

Value =2 = Inside delta - Ul
Value = 3 = Inside delta - IU
Value = 4 = 2-phase L1 shorted
Value = 5 = 2-phase L2 shorted
Value = 6 = 2-phase L3 shorted

Value =100 = 100A
Value =100 = 100A
Value =100 = 100A
Value =100 = 100hp
Value =100 = 100kW
Value =100 = 100kVA
Value = 100 = 100kVAr
Value =100 = 100A
Value =100 = 100A
Value =1 = 10000kWh
Value =1 = 10000kVArh

Value=1=1

Number of starts (high precision)

D Phase current L1, L2 and L3 indicate the current through the softstarter, while the Max
phase current is always the line current.

3 High Range alternatives are available for a few signals where there is a possibility for the
values to wrap. The values are 16-bit so the maximum value for each signal is 65535. The High
Range alternatives have different scaling and will never wrap around but instead have lower
precision.
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3.5.

Digital output telegram

From PLC to the softstarter.

FIELDBUS COMMUNICATION

Use Modbus function code 15 (OFh), Force Multiple Coils.

Protocol Modicon Bit Data Description
Address Address
0000h 1 0] Start Commence a start when signal is set.
0001h 2 1 Stop Commence a stop when signal is negated.
0002h 3 2 Fault reset Reset signal for possible events.
0003h 4 3 Auto mode This must be set for controlling the motor.
0004h 5 4 Slow speed re- Perform slow speed reverse when signal is
verse set.
0005h 6 5 Slow speed Perform slow speed when signal is set.
forward
0006h 6 Spare
0007h 7 Startl Startl if sequence start.
0008h 8 Start2 Start? if sequence start.
0009h 10 9 Start3 Start3 if sequence start.
000Ah 1 10 Motor heating  Perform motor heating when signal is set.
000Bh 12 1 Stand still Perform stand still brake when signal is set.
brake
000Ch 13 12 Start reverse Commence a reverse start when signal is
set.
000Dh 14 13 Spare
O0OEh 15 14 Emergency Set to “1” to enable emergency mode.
mode
OO0OFh 16 15 FBT toggle bit  See Fieldbus Tasks.
0010h 17 16 User defined Set to “1” to trigger user defined protec-
trip tion.
0011h 18 17 Switch to re- Switch to remote control when signal is set
mote control (rising edge triggered).
0012h 19 18 Pump cleaning Perform automatic pump cleaning when
automatic signal is set.
0013h 20 19 Pump cleaning Perform forward pump cleaning when sig-
forward nal is set.
0014h 21 20 Pump cleaning Perform reverse pump cleaning when signal
reverse is set.
0015h 22 21 K4 relay com- Set “1” to activate the internal K4 output re-
mand lay. Note that parameter 10.4 K4 function
has to be set as “Fieldbus”
0016h 23 22 K5 relay com- Set “1” to activate the internal K5 output re-
mand lay. Note that parameter 10.5 K5 function
has to be set as “Fieldbus”
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3.6.

FIELDBUS COMMUNICATION

Protocol Modicon Bit Data Description
Address Address
0017h 24 23 K6 relay com- Set “1” to activate the internal K6 output re-
mand lay. Note that parameter 10.6 K6 function
has to be set as “Fieldbus”
0018h 25 24 1DOO0 relay Set “1” to activate the external 1DOO output
command relay. Note that parameter 11.9 1DOO func-
tion has to be set as “Fieldbus”
0019h 26 25 1DO1 relay Set “1” to activate the external 1DO1 output
command relay. Note that parameter 11.10 1DO1 func-
tion has to be set as “Fieldbus”
001Ah 27 26 2DO2 relay Set “1” to activate the external 2DO2 output
command relay. Note that parameter 11.11 2DO2 func-
tion has to be set as “Fieldbus”
001Bh 28 27 2DO03 relay Set “1” to activate the external 2DO3 output
command relay. Note that parameter 11.12 2DO3 func-
tion has to be set as “Fieldbus”
001Ch 29 28 Spare
001Dh 30 29 Spare
001Eh 31 30 Spare
001Fh 32 31 Spare

Analog output telegram

From PLC to the softstarter.

All analog data is represented as 16-bit values.
Use Modbus function code 16 (10h), Preset Multiple Registers.

Protocol Modicon Data Representation
Address Address
0002h 40003 FBT Control Word This register is used to read parameters (see
fieldbus tasks).
0003h 40004 Fieldbus AO 1 (FBT Parameter 12.37 Fieldbus AO1 decides the use
Argument 2 or Inter- of this register. If set as "FBT Argument 2”, it is
nal analog output) used to write parameters and set time (see
fieldbus tasks). If set as “Internal analog out-
put” this value of this register controls the in-
ternal analog output. Note that parameter 10.8
AO type needs to be set as “Fieldbus [%]".
0004h 40005 Fieldbus AO 2 (FBT Parameter 12.38 Fieldbus AO2 decides the use
Argument 3 or Ex- of this register. If set as "FBT Argument 3, it is
ternal analog out- used to write parameters and set time (see
put) fieldbus tasks). If set as “External analog out-
put” this value of this register controls the ex-
ternal analog output. Note that parameter
11.14 1A0O0 type needs to be set as “Fieldbus
[%]”.
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4.1.

4.2.

5.1.

FIELDBUS COMMUNICATION

Modbus TCP - A set-up example

Softstarter PST Modbus TCP communication

This document describes an application example between a Modbus TCP master (PLC CPU,
PC, etc.) and the ABB softstarter PSTX using the built-in Modbus TCP interface.

Please always use the actual softstarter manuals. In this particular example following docu-
ments has been used:

— Softstarter PSTX Installation and commissioning manual, document 1SFC132081M0201

Settings

1. Set the softstarter network settings and field bus communication.
Either set Fieldbus IP address, Fieldbus IP gateway and Fieldbus IP net mask to desired
network configuration or enable Fieldbus IP DHCP client parameter to receive the IP con-
figuration from your DHCP server.
Enable fieldbus control (Fieldbus control = On) to allow softstarter control from the
fieldbus.

2. Select the Anybus CompactCom interface.
The previous changes are taken in effect when the fieldbus interface is changed. Change
parameter FB interface connector to Anybus.

Fieldbus Tasks

By using Fieldbus Tasks it is possible to read/write parameters and set the real-time clock.

Which task to execute is selected by filling in the FBT Control Word. There are three signals
for arguments to the task:

— FBT Argument 1 is packed together with the Task ID in the FBT Control Word.

— There are two additional 16-bit arguments in separate analog output signals, FBT Argu-
ment 2 and FBT Argument 3.

To control when the task is executed, the digital output signal FBT Toggle Bit shall be
changed. The softstarter will detect the change, execute the task, fill in the return values, and
toggle the digital input signal FBT Toggle Bit as acknowledgement. Thus, the return values
must be disregarded if the two toggle bits have different value.

FBT Control Word

The control word is a 16-bit analog output value sent from the PLC to the softstarter. It con-
sists of a Task ID and an 11-bit argument packed together.

15 14,13,12, 11 10,9,8,7,6,5,4,3,2,1,0

- Task ID - Argument 1
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FIELDBUS COMMUNICATION

5.2. TaskID

The task identifier controls which function should be performed.

Task ID Task Response ID
Positive Negative
0] No task 0] -
1 Request parameter value, lower word 2
2 Change parameter value 1 2
3 Set date and time 1 2
4 Request parameter value, upper word 1 2

5.3. ResponselID

The response ID is the softstarter response to a task. It tells whether a task was executed
successfully. If there was an error, an additional error code is returned in the FBT Return Value
analog input. The Response ID is transmitted as two digital input signals, FBT Response O
and FBT Response 1.

ResponseID FBT Responsel FBT Response O Explanation

0 0 0 No response

1 0 1 Task executed

2 1 0 Task cannot be executed (with error
number)

3 1 1 Reserved.

5.4. Error codes

The following error codes are sent when a task cannot be executed.

Error code Explanation

0] Illegal parameter number

1 Parameter value cannot be changed
3 Lower or upper limit violated

4 Invalid argument

5 No error

6 Invalid task number
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5.5.

5.5.1.

5.5.2.

5.6.

5.6.1.

5.6.2.

5.7.

FIELDBUS COMMUNICATION

Request parameter value, lower word

This task reads the lower 16 bits of the specified parameter. See chapter 5.9 for parameter
number and value scaling information.

Arguments

- FBT Argument 1: parameter number.

Return Value
— Response ID 1 and parameter value in FBT Return Value on success.

— Response ID 2 and error number in FBT Return Value on failure.

Change parameter value

This task writes a specified value to a parameter. See chapter 5.9 for parameter number and
value scaling information.

Arguments

— FBT Argument 1: parameter number.

— FBT Argument 2: parameter value (lower word).

— FBT Argument 3: parameter value (upper word).

Return Value
— Response ID 1 on success.

— Response ID 2 and error number in FBT Return Value on failure.

Set date and time

This task updates the real-time clock on the softstarter. The date and time fields have the fol-
lowing limits:

Year: 0-63 (2000-2063)

Month: 1-12

Day: 1-31

Hour:0-23

Minute:0-59

Second:0-59
5.7.1. Arguments

FBT Argument 2: year, month, day and least significant bit of seconds.

15 14,13,12,11,10,9 8,7,6,5 4,3,2,1,0

sO year month day
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5.7.2.

5.8.

5.8.1.

5.8.2.

5.9.

FIELDBUS COMMUNICATION

FBT Argument 3: hour, minute, seconds, bit 1-5.

15,14,13, 12,11 10,9,8,7,6,5 4,3,2,1,0

hour minute seconds, bit 1-5

Return Value
Response ID 1 on success.

Response ID 2 and error number in FBT Return Value on failure. In case the supplied time
didn’t differ from the set time, error code 5 (no error) is used.

Request parameter value, upper word

This task reads the upper 16 bits of the specified parameter. See chapter 5.9 for parameter
number and value scaling information.

Arguments

— FBT Argument 1: parameter number.

Return Value
— Response ID 1 and parameter value in FBT Return Value on success.

— Response ID 2 and error number in FBT Return Value on failure.

Parameter numbers and values

To access parameters from the fieldbus, a unique parameter number is needed, this can be
found in document 1SFC132081M0201, Chapter 7.19 Complete parameter list, Table 5.

Since the parameter values need to be represented as integers on the fieldbus while, the pa-
rameter values with greater precision need to be scaled. In document 1SFC132081M0201,
Chapter 7.19 Complete parameter list,Table 5, there is a column specifying the number of dec-
imals for each parameter.

- Parameter values that are read from the fieldbus needs to be divided by 1Qnumbers of decimals

- Parameters values that are written from the fieldbus needs to be multiplied by 1Qnumbers of

decimals

For example:
The parameter Kick start time has parameter number 24 and 2 decimals. To read this param-
eter:

1. Set FBT Task ID to 1.

2. Set FBT Argument 1 to 24.

3. Toggle FBT Toggle Bit output and wait for the FBT Toggle Bit input to update.
4. Response ID 1 should now contain value 1, indicating success.
5

. FBT Return Value contains the value 50 (this is an example and depends on the actual set
value).

6. The return value should be interpreted as 50/102 = 0.5s.
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FIELDBUS COMMUNICATION

To change the Kick start time parameter to 1s:

1
2.
3.

Set FBT Task ID to 2.
Set FBT Argument 1 to 24.

Set FBT Argument 2 to 1*102 = 100.

. Set FBT Argument 3 to 0 as 100 <= 65535 which means it doesn’t require more than 16

bits.
Toggle FBT Toggle Bit output and wait for the FBT Toggle Bit input to update.

Response ID 1 should now contain value 1, indicating success

5.9.1. Negative values

Negative values are represented internally using 32-bit two's complement numbers.

Example:
Setting parameter 17.5 PT100 reset temp (parameter number 249) to a value of -25°C:

The two’s complement of -25 is FFFFFFE7hex. The upper word is FFFFhex and the lower FFE7ex,
in decimal notation 65535 and 65511.

1.

2
3
4.
5
6

Set FBT Task ID to 2 for Change parameter value.

. Set FBT Argument 1 to 249 to specify the parameter.

. Set FBT Argument 2 to 65511 to specify the lower word.

Set FBT Argument 3 to 65535 to specify the upper word.

. Toggle FBT Toggle Bit output and wait for the FBT Toggle Bit input to update.

. Response ID 1 should now contain value 1, indicating success.

6. Example application with Automation
Builder

This section shows a demo about how to start and stop motor by sending commands from
fieldbus that is controlled by Programmable logic controller (PLC). We use Automation Builder
as an example platform and show the demo about building such communication setting.

6.1. Create a new project in Automation Builder

We perform the following steps in Automation Builder 2.1 for PLC AC500 PM573.

1.

2.

Open Automation Builder

Select File->New Project->AC500 project->OK
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FIELDBUS COMMUNICATION

3. Select the correct PLC CPU in Search object name ...-> Add PLC.

Categories

- PLC - AC500 V2
PLC - AC500 V3

Name

07KT98-ARC-AD
07KT98-ARC-DP-AD
07KT98-ARC-ETH-AD
07KT98-ARC-ETH-DP-AD
07KT98-ETH-DP-AD
£ AC500 PM554

£ AC500 PM554-ETH
1 AC500 PM556-ETH
1 AC500 PM5B4

£ AC500 PM5B4-ETH
1 AC500 PM5EE-ETH
ACE00 PM572

[ AC500 PM573-ETH
<

Short Description G

07KTS8-ARCNET adapter ¢
07KT98-ARCNET-DP adap
07KTS8-ETH-ARCNET ad=
07KT38-ARCNET-ETH-DP
07KT38-ETH-DP adapter
8DI/EDO-T, 24VDC or 115
2DI/6DO-T, 24VDC, Ether
8DI1/6DO-T, 24VDC, Ether
EDI/EDO-T/2A1/1A0, 24VI
EDI/EDO-TA2A1/1A0, 24VI
GDI/EDO-TA2A1/1A0, 24VI
ACS00CPU 128kB

ACEDDCPU 512kB, Bthemi ¥
>

Close this dialog after each transac Display all versions

Close

4. Check that the correct device type is selected by double clicking the device name in De-
vices field. Check that the correct Terminal Base Type is also selected for the tag for Hard-

ware.
Devices ~ 1 X PLC_PSTX X
= pstx hd
_| PLC_PSTX (PM573-ETH - TB521-ETH) PM573-ETH Parameters PLC AC500 V2
= stx_control .
0 p - OME73-ETH Hardware PMSc Type: PM573ETH
L7 App
I0 Bus - " Terminal Base Type: TB521-ETH
- nformation

H Interfaces
B4 coM1_Online_Access (COM1 - Online Access) Change PM [ TB type
m COM2_Online_Access (COM2 - Online Access)
m FBP_Online_Access (FBP - Online Access)

= E Ethernet
@ ETH1 (ETH1) [] change to AC500 V3 PLC
@ Protocols (Protocols)

= @ Extension_Bus
B slot_1(Tas24)
Bl Slot_2(Tas24)
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6.2. Connect to PLC using TCP/IP

1. Control the IP address for the device is also correct by right click the device name and then
chose communication setting. The IP address should be the address of PLC CPU device.

FIELDBUS COMMUNICATION

Devices ~ 0 X
= _]] .D:S'J‘_X' -
- [Z]|PLC_PSTX (PM573ETH - TB521-ETH |
=&l pstx_contral Comrmunication Settings...
":j' App Source download... H)
P —
IO_Bus :
- Copy
= Interfaces
B coM1_online_Access (CO dos s
BT com2_orline_Access (cof & Cut
B4 FeP_Online_Access (FBP - 3¢ Delete
. ETH th i
gy Ethernst Rename
Zl EmiEHY _
@ Protocols (Protocols) Akl ninece
= @ Extension_Bus Update objects
Bl slot_1(ras24 ) Add Folder...
Slot_2 (TAS24
B sot2mas2 " Edit Object
Compare Objects
Export L4
Chedk configuration

2. Control that the IP address for PC and the PLC is in the same network but not the same IP
address. This can be checked by using through Ethernet Properties.

3. Click the icon “Login”, for building the configuration and checking if configuration is cor-

rect.

4. If the configuration is correct, a program for building PLC should be opened in the PLC en-
vironment, CoDeSys. Automation Builder will ask for downloading PLC configuration.
Choose “Update”. Automation Builder will confirm that the program has changed.

Automation Builder

- The PLC configuration needs to be updated. An update requires full PLC download.
no online change will be possible.

Do you want to update PLC configuration or keep the downloaded PLC
configuration for online change?

Keep

Automation Builder 2.1 - Premium

o Login

The program has changed! Download the new program?

Yes Mo Cancel
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FIELDBUS COMMUNICATION

6.3. Build a START-STOP program

We perform the following steps for building our start-stop demo program in CoDeSys.

1. Open CoDeSys by double clicking your application in Devices file in Automation Builder, if
itis not opened yet.

= psix
= PLC_PSTX (PMS73-ETH - TB521-ETH)

= B[Hpstx_conh’ol

o} App
10_Bus

E Interfaces
m COM1_Online_Access (COM1 - Online Access)
m COM2_Online_Access (COM2 - Online Access)
m FBP_Online_Access (FBP - Online Access)

ETH

=ay Ethernet

2. Open program window by double clicking the default program in POUs in CoDeSys.

B

File Edit Project Irsert Extras Online  Window Help

o EleleiaeEiE s

3. We choose to use LD as the language of the POU here by right click POUs -> Add Object...-
>Insert Name of the new POU -> Choose “LD” for “Language of the POU” -> OK.

" CoDeSys - Application ACS00PRO
File Edit Project Insert Extras  Online Window Help

EI |®|’.dl%|§;|@| ‘X’ll %llﬁl%lﬁi‘j |ﬂ Mame of the new POL: 'damo—

New POU X

Type of POU Language of the POL Cancel
| | * Program oL
: - r &
b4 PLC_PRG [PRG) Add Object... Funetion Block 0
. " Function " FBD
Rename Object... Return Type: " SFC
Edit Object BODL = 57
. f'"
Copy Object BrE

Delete Object

4. Select the first network, create a contact “START” (by CTRL+K and putting name at “??7?”")
and three coils “BITVAL[1]”, “BITVAL[2]” and “BITVAL[4]” (by CTRL+L) in first network. We
set BITVAL 1, 2 and 4 because we want to set TRUE for “Start”, “Stop” and “Auto mode” ac-
cording Section 3.5 for data transmission.

| coils
staRT contact "START" BITVAL[1]
| O
BITVALI2]
—
first network 0001 BITVALII
Ly
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FIELDBUS COMMUNICATION

5. Select the data type for BITVAL as “ARRAY [1..16] OF BOOL” in “Declare Variable” window.
We choose BITVAL as an array of 16 because fieldbus task has 16 bits according to Section

5.

Declare Variable

Class

Mame

AR

Symbol list

| [BiTwaL

*
Cancel

Tupe
|4RRe [1.16] OF BOOU J

Initial W alue Address

|Global_‘Yariables

Ef|

I

[ COMSTANT

Comment;

[~ BETAIM
[~ PERSISTEMT

6. Create a second network by CTRL+T

7. We continue create a function block “BLINK” by CTRL+B and select Standard Function

Blocks -> Util.lib -> signals-> BLINK(FB)->Ok. We name the BLINK function block as blink.
We set t#2ms for TIMELOW and TIMEHIGH.

[ e

tandard Functio
Jser defined Functi
itandard Programns
lzer defined Programs

[V Stuctured

3 Standard Function Blacks
m C:4Program Files [«86]%w4E B AutomationB uilder CODE 5542, 3.9. 554 Librany\ standard. lib
C:\Program Files [#86]%4BB \AutomationBuilder\CODE 5542, 3.9. 554 Libranyt ecsle. b
C:M\Program Files [#86]%4BB\AutomationBuilders CODE 57542, 3.9. 554 Librany\ kil lib
Ea analog mahitors
E@ bit/byte functions
(23 controller
(22 function manipulators
B[ mathematical functions
=] a3 signals
FREO_MEASURE (FE]

~[E] GEM [FB)
E C:A\Program Files [#86]5Common FileshCAd-T argets\ABB_ACSOMNACEO0_ V124 Libran\SvsLibs\SysLibTime. ib
B[] C:4Program Files [+86]\Common Files\CAS-T argets\ABB_ACSO0MACE00_V1 25 Librar S yslibshSysT askinto. b
B m C:4Program Files [+86]\Common Files\CAA-T aigets\ABB_ACS00CS00_Y1 24LibraryBusDiag ib
B m C:4Pragram Files [+86]\Common Files\CAA-T aigets\ABB_ACS00MCS00_Y1 25LibrarS pslnt_ACS00_%10.lb

N B i

Cancel

~ 0Ok |
I

8. We continue create a function block “ETH_MOD_MAST” by CTRL+B and select Standard
Function Blocks -> Ethernet_AC500_V10.lib -> MODBUS_TCP-> ETH_MOD_MAST(FB) -> OK.

Input assistant

Standard Function s
User defined Function Blocks
Standard Programs

User defined Programs

] ‘ GEN [FB]

m C:\Program Files [#B6]Common Files\Céd,-Targets\ABE_ACRO0NWCR00 V1 24 Librany\SysLibehSpsLibT ime.ib
B ) C:\Program Files (+85)\Common Files\CAA-T argets\ABE_ACSO0MACSD0 V124 Librar\SysLibs\SysTasklnfo.lib
m C:\Program Files [xBB]sCommon Files\CAA-T argets\ABB_ACS00MACE00_W1 24 Library\BusDiag. b

' m C:\Pragram Files [«BE]sCommon Files\CAA-Targets\ABB_ACB00MACE00_W125Librarg\Sysint_aC500_10.ib
m C:\Program Files [#B6]Common FileshCéd,-Targets\ABE_ACR00NWCE00_1 24 LibranyhSysE st_aCo00_%10.Ib

= m C:\Program Files [xBE\Commaon FileshCas-T argets\ABE_ACSO0YACH00_ V1 24LibraryAEthernet_ACS00 %106
-1 DNS
-2 General

Cancel

Al
E=N

ol

O-E-@
S
) B
o

[ MODEUS_TCP

ETH_MOD_INFO [FE]
ETH_MOD_MAST [FB]
ETH:_MOD_INFT [FB)
ETHx_MOD_MAST [FB)

3 sMTP
B~ UDP_IP .
v Stuctured
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FIELDBUS COMMUNICATION

Now, we should have two function blocks in network 0002.

0001
START BITVAL[1]
| (
| (O
BITVALI2)
BITVALI4]
0002
blink 777
BLINK ETH—MOD—MAST .........................
ENABLE ouT| EN DONE
2 ms JTIMELOW 29545107 ERR|—
l#2ms{TIMEHIGH |~ = ??7-|P_ADR  ERNO|—
222JUNIT_ID
227FCT
222 JADDR
2774NB
225]DATA

The ETH_MOD_MAST is a function block for sending/receiving OpenModbus on TCP/IP tele-
grams to/from an OpenModbus on TCP/IP Server. The function has inputs: EN, SLOT, IP_ADR,
UNIT_ID, FCT, ADDR, NB and DATA. Their definition is available from CoDeSys -> Resources ->
Library Manager.

B CoDesys - Application ACSOOPRO"
Sle Edt Project Insert btras Online Window Help

B | 2AGR % (B ] ]

Resources
[Bron Ly Ve ==

ation (VAR_CONFIG) SysLivlnitLibrary lib 25.6.18 18:33:14 - or wilhin the HBA er 3 UNIT_ID.
emet_ACS00_V10ib 25.6.18 18:33:14: glol SYSLIBCALLBACK LIB 25.6.18 18:33:14

it a8 o -
Sysint_AC500_V10lib 25.6.18 18:33:14 EN: BOOL FALSE; SE->TRUE edge atinput EN*
S AR s st 18 Yot Lo o 6
PAR  DWORD =0
o G el
C BYTE =0,
otr foro o FS——
107114 132048 S 2 oro 2
oo oromo -t peratonc s rss i n st i e it o5 Sentorto e et
e v
p—
DONE: BOOL = FALSE; (*1: execution finished when output DONE = TRUE?) v
. s

- MOD_INFD (FB)
ETHi_MOD_MAST (FB)

Qsmte

Quorp

ETH_MOD_WAST

En:BooL DONE : BOOLI—
sLoT : BYTE ERR: BOOL|—
iP_ADR : DWORD ERNO : WORD|—
UNIT_ID: BYTE
FoT BYTE

[ADDR : WORD
e - worD

DATA: DWORD

POUS|E D ot pes] ] Visuazatons @ GlobalVariab
To enable this function block, it is required to send a FALSE->TRUE edge at input EN and
therefore we introduce BLINK, which is for creating a flip-flop signal.

9. Both IP_ADR (IP-address of MODBUS TCP/IP device) and DATA (the data to send) require
DWORD inputs. We can convert our IP-address with a box, “IP_ADR_STRING_TO_DWORD”,
and convert data with a box, “ADR”.

a) Select the bar in front of IP_ADR

799
ETH_MOD_MAST

EN
2928L0T
77974IP_ADR

DONEF——

ERR[—
ERMO—

222 JUNIT_ID
272 JFCT
277 -|ADDR
277-|NB

272 |DATA
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b) Choose Insert-> Insert at Blocks-> Box

" CoDeSys - Application ACS00PRO™

File Edit Project
B| B|@]est

£, Resouces
B3 Global Variab

. Global_%
e . Wariable_

-2 library Etherne
2] libramy lecsfc.|
-2 libram Syslnt_
-1 library SysLibl
9] library SysLibt
- library SysLib®
-2 libram SysT az
- [] library Uil ib -
- (i) Tools

- (78 Alarm configu

{ ey O ey R oy Y oy Y oy Y oy Y oy Y oy O o |

Library tManag

""" FLC - Browse
----- PLE Configur.
""" Sampling Trai
""" ﬁ Target Setting
""" T azk configu
""" Q Wiatch- and F
""" '}@‘ YWorkspace

Insert  Extras

Online
Declaration Keywords ...
Types ...

Mew Declaration

Metwork (before)
Metwark (after)

Contact
Contact (negated)
Parallel Contact

Parallel contact (negated)

Function Block ...
Rising edge detection
Falling edge detection
Timer (TOM)

Coil

‘Set’ coil

‘Reset’ coil

Box with EM
Insert at Blocks

Jump

Return

Comment

Window  Help

Ctrl+T

Ctrl+K
Ctrl+G
Ctrl+R
Ctrl+D

Ctrl+B

Ctrl+L
Ctrl+|

FIELDBUS COMMUNICATION

100 % - l:ll:¢| 1F

%

‘0001|PROGRAN PLC_P
0002[VAR

0003 OUTPUT:BOOI
0004 tcp_write: ETH_
0005 ERRO:BOOL;
NANEF ERkIC WOE T

nfo.lip 25.6.18 18:33:14

m.lip 25.6.18 18:33:14
Librarylip 25.6.18 18:33:14
ALLBACKLLIB 25.6.18 18:331
ib25.6.18 18:33:14
“500_V10ib 25.6.18 18:33:1¢
C500_V10.lib 25.6.18 18:331
ACE00_V10.10ib 25.6.18 18:33

5
DS
General
CHP
* Input Ctrl+U
Output
Box
Assign Ctri+A
= *

The default box is “AND”, and we insert “IP_ADR_STRING_TO_DWORD” at the blue marked
area, then press ENTER. We can also find this box by pressing F2 when the marked area is se-
lected. We insert IP-address in front of IP_ADR of “IP_ADR_STRING_TO_DWORD”".

tcp_write
ETH_MOD_MAST
EMN DOMNE
0—-5LOT ERRI—ERRO
IP_ADR_STRING_TO_DWORD ,— IP_ADR ERNO—ERMNO
192 168.0.0°HIP_ADR O—UMNIT_ID
154FCT
ADR 0—-ADDR
BITVAL— —| 16—MB
DATA
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10. Set:

— The name of the block to tcp_write

- SLOTtoO

— IP_ADRto IP address of MODBUS/TCP device

- UNIT_IDtoO

- FCTto1l5

— ADDRto 0, according to Section 3.5, the first Protocol Address is 0000h.
- NBto16

— ERRto ERRO (nhew BOOL variable)

— ERRNO (new WORD variable)

3 ” ” s
11. Insert a coil named "OUTPUT” in the second network. Thus we have complete two net-
works here.
®y demo (PRG-LD) =N =
0001|PROGRAM demo
0002VAR
0003 START:BOOL;
0004 BITVAL: ARRAY [1.16] OF BOOL;
0005 BLINK: BLINK;
0006 tcp_write: ETH_MOD_MAST;
0007| ERRO: BOOL;
0008| ERNO: WORD;
0009 OUTPUT: BOOL;
0010 ENDJ’#.R'
0011
o042
< >
{Ien;
START BITVAL[1]
I {
i {
BITVAL[2]
BITVAL[4]
0002
blink tcp_write
BLINK ETH_MOD_WAST OU{TPUT
ENABLE ouT]| EN DONE]| { )7
#2ms—TIMELOW [ 04sLOT ERRI—ERRO
#2ms—TIMEHIGH [~ & IP_ADR_STRING_TO_DWORD IP_ADR ERNO|—ERNO
192.168.0.0'4IP_ADR O0—UNIT_ID
154FCT
ADR 0—ADDR
BITVAL- 16-{NB
DATA

12. Control that we have correct data type for all the variables we created inside networks.

@ derno (PRG-LD)

0001|PROGRAM demo

D002VAR

0003 START:BOOL;

0004 BITVAL: ARRAY [1.16] OF BOOL;
0005  BLINK: BLINK;

0006  tcp_write: ETH_MOD_MAST,
0007| ERRO:BOOL;

0008 ERNO: WORD;

0009 OUTPUT:BOOL;
0010[END_VAR
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13. Now we want to create one control button for signing the value of “START” from the first
network into TRUE. We do this by Visualization -> right click -> Add object -> Write name
of the new Visualization as “view” -> OK

File Edit Project Insert Extras Online Window He

B| 5@l &% (|

Zationg

F‘DUSI.T: Data t_l,lpesl Visualizat...l% Hesourcesl

YNew Visualization

*
Marne of the new Yisualization: IViEM (] |

Cancel

o [
A
14.We draw a shape as the button -> double click the shape -> Regular Element Config-
uration -> Input -> check Toggle variable -> insert “demo.START” ->0OK

Regular Element Configuration (#0)

Categary:
Text ¥ Toggle varisble IdEI‘ﬂD.ST-"-"-Hﬂ
Teut variables C |
Colarvariables [~ Tap variable | EEE |
Y ariables
: T TapFALSE
Text fu_:ur toaltip
Securty [ Zoom ta vis: I
Prograrnmability
[ Execute program: I J
[7 Textinput of vanable 'Testdizplay’
ITE:-:t vI b i I
[~ Hidden  Max: |

Dialog title: |
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FIELDBUS COMMUNICATION

15. We configure this program into task configuration by Resource -> Task configuration ->
Right click Task configuration -> Append Task -> Insert t#10ms in Properties in Taskattrib-
utes. Then we need to sign our program to this task by right click NewTask-> Append Pro-
gram Call-> Choose demo(PRG) by clicking the select button in Program Call ->OK.

B CoDeSys - Application. ACS00PRO
ile Edit Project Insert Extras Online  Window

Help

H| Blglednseds e

52 Resaurces
B3 Global Variables

| Task configuration

<

Puus]_'t: Data lypes\/lsuallzal | 52 Resaurces

>

Bl @l Task configuration "
: o Taskattibutes |
b Global Variables & Syslem events
@ Variable_Configuration [¥&F_CONFIG) @l NewTask
Name: NewT ask
B3 (21 libvary Ethemet_ACS00_V10.ib 256,18 18:3314: glo Hame NeuTs
B0 library lecsfe. b 2.6.14 10:37:46: global varisbles Priariy(0.31) [10
B2 fibrany Spsint_AC500_V10.lb 25.6.18 18:3%14: globg
(20 library SysLiblritLibrary.ib 25.6.18 18:33:14: global va U{'EE
-2 library SysLibMern b 25.6.18 18:33:14: global variabl o @B
E3-(13 library SysLibTime b 25.6.15 18:3%14: global variabl € fieewhesling
B+ library SpsTaskinfo.ib 25,616 18:33:14: global variab ® el
B0 fibrany Ut 19,1114 15:20:48; global variables
- (58 Teols " tiggered by extemal event
(8 Alarm configuration Fropetties
- () Library Manager Interval [e.g. t200ms).  |tH10ms [ =]
B Log
PLC - Browser
- [{ PLC Configuration Watchdog
= ) I~ Activate watchdog
Sampling Trace
 fi Tanget Setlings Timele.q. t#200ms) %
n Senstivity 1
-3 Workspace
Data all:
Check task configuration
Aftention: Unused 1/Os will not be updated (see target settings)!
Implem of POU 'demo

Impl oftask ‘MainTask’

16. Right click on the NewTask and select Append Program Call.

A Task configuration
B[4 Task configuration
g Taskattrbutes
& System events
' NewTask Insert Task
Append Program Call
Cut Ctrl+X L
Copy Ctrl+C
Paste Ctrl+V eclin
Delete Del ed by
Set Debug Task ed by
Enable / disable task -
Interval [e.g
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17. Select the demo program call

|| Task configuration [ Gl

E-----@Taskconﬂgurat\on i

b g System events = Pragram Call l
Bl {FaNewTask
? =) demo() ] Program Call: [dlema(: D

<« b L |

6.4. Build and run the PLC demo program

Use the key, F11, to build the program once. Login and start project from Automation Builder
by clicking Alt+F8 to login the CodeSys. Click yes to login

Login

The program has changed! Do you want to load the changes?
[OMLINE_CHANGE)

Yes Mo Cancel

Click F5 to start. Switch to CoDeSys and click Alt+F8 to login demo. The program can be con-
trolled with the view from CodeSys

L) = |[=][=]
0001 START = [0 ]~

p_write
ERRO =
ERNO =12291

OUTPUT =

START BITVAL[1]

1 B
BITVALIZ]
_(l)_
BITVAL]

_(I)_

blink tep_write
BLINK ETH_MOD_WAST OuTPUT
D

E ouT 1—

—TIMELOW —SLoT ERR—ERRO
-TIMEHIGH [~ & [P_ADR_STRING_TO_DWORD IP_ADR  ERNO—ERNO=12291
192.168.0. 0'—IP_ADR 0+

ADR

BITVAL
Hview (=R =
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7. Contact us

For more information, please contact
your local ABB representative or visit
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